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Chapter 1 Introduction to PhotoLib3.0 
1.1 Base Characteristic 

1 Support Twain interface and VFT interface frame grabber； 

3 Support WIN95, WIN98，WIN2000 and WINXP operation 
systems； 

5 Support color adjustment, image transform , Morphological 
processing , image enhancement.   

6 Support 24 bit true color image capture.  Support RGB、
CMY、HSV、YUV color models processing and analysis； 

7 Support Undo，Redo； 

8 Support geometry parameters measurements； 

9 The analysis results can output to html files  or Clipboard. 
Print can be performed using specified format or report. The 

image can be printed with photo quality .
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Chapter 2 PhotoLib3.0 Installation 
2.1  System Requirements 
2.1.1 Hardware requirements 

CPU PII200 above 

Memory 64M above 

Hard disk 200Mabove 

Others CDROM、USB Port or Frame Grabber 

Selectable hardware The digital microscope (Sunny Group recommended) or the related products from other 

companies 

2.1.2 Software requirements 

Microsoft Windows operation 
systems(Win95,Win98,Win2000，Win XP) 

2.2  Hardware Installations 

Please install the hardware according to their specific instruction 
manual。 

 

 

Fig.2.2-1：The connection of the digital microscope (SAM) 
with personnel computer 

Installation  of the digital microscope on a personnel computer is 
as follows： 

1 Insert the PAV cable�s S end into the video head. 

2 Insert any of the C-VIDEO or S-VIDEO BNC connector plugs 
into A/D board. 
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3 Insert the USB end of the A/D board into the PC�s USB port. 

4 If the computer has frame grabber(support video for 
windows) ，the user can connect C-VIDEO or S-VIDEO plugs 

with the frame grabber 。  

Connect 12VDC power plugs with PAV cable�s power socket as 
shown in Fig2.2-1  

2.3  Software Installation 

Insert  PhotoLib  CDROM into CDROM driver，the 
installation program will then install the application 

automatically，as shown in Fig.2.3-1. If you have selected the 
hardware from us， please specify the application program and 

the driver. Select �next�，the system will finish the next 
installation procedure automatically(If you have selected the 

hardware from other companies, please just select our application 
program, after the installation of the application, please install 

the hardware driver or the hardware supplier). 

 
Fig 2.3-1 Software Installation 
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2.4 Software Registration  

After the installation, double click the PhotoLib icon on the 
desktop in the Run->Program->PhotoLib, a dialog will be shown 
as in Fig.2.4-1. Please copy your hardware serial number in the 

edit box and send it to your software vendor to get the 
registration code. Your vendro will send you a key.dat file 

according to your registration code. After receive this file, please 
import this file or copy this file into your application program 
directory by hand. Run the application again, the program will 

run as normal and you can run the PhotoLib application. Make 
sure to keep a copy of key.dat in a safe place or make a backup of 

this file before you want to delete the application. 

 
图 2.4-1 The hardware serial number of the user�s software 

 

Fig.2.4-2  Software Registration 

2.5  Execute PhotoLib 

Double click the PhotoLib Icon, the program should work 
normally now。 
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Chapter 3 PhotoLib3.0 GUI 
3.1  Description of the PhotoLib3.0 GUI 

Double click PhotoLib icon, a user friendly interface will be 
shown as in Fig.3.1-1.The GUI mainly includes ToorBar, 

StatusBar, Layer Manager, Measurement Window、PaletteBox 
and Image Window。Detailed menu function will be introduced in 
Chapter 4. The Toolbar item functions are shown in Fig.3.1-3，

The image information is displayed in the StatusBar. As an 
example, we now open an image with cells and constitute a new 
layer, make a label (circle or ellipse) on a single cell. The GUI at 
this time should be look like Fig.3.1.2. Now we found there are 

three layer in the layer manager, i.e. background (Image layer)，
the second layer(made by the system itself), the third layer which 
is made by ourselves. When we need to label the image, we must 

let the current layer selection on the other layer, not the 
background layer (Detailed description will be given in Chapter 

4)。In the measurement window, some basic information are 
shown, this include e.g. No, Name, Center Pos, Radius, Area, 

Perimeter, Angle, Start Pos, End Pos). 
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Fig.3.1-1 The Application GUI 

Fig.3.1-2 The Application GUI after open an image 
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Fig.3.1-3 ToolBar and Its Item Function 
Chapter 4 The Main Functions of the PhotoLib3.0 

4.1  File Menu 

4.1.1  New(N)�Ctrl+N   

Use the New command to create an empty 24 bit image window of 
the specified dimensions and class. The image width and height 

can be specified in the pop up dialog as shown in Fig 4.1-1 

When an empty window is created, all pixels are initialized with 
the lowest intensity value for its type (e.g. 0). 

Width 
Enter image width in pixels if the Unit field is set to Pixel. The width value establishes the number of pixels the new 

image window will contain in the horizontal direction. Default value is 320 

Height Enter image height in pixels if the Unit field is set to Pixel. The height value establishes the number of pixels the new 
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image window will contain in the vertical direction. Default value is 240. 

 

 
Fig.4.1-1 Constitute New Image Window 

4.1.2  Open(O)...  Ctrl+O  

Use the Open command to open an existing image file(see 
Fig.4.1-2) Open can also be used to preview a miniature of the 

image, or to view its statistics and information without actually 
having to open the image itself. These capabilities can be used to 

locate a particular image quickly.  

PhotoLib® supports, and will open, many image formats. These 
are identified in the File type list box.  

When you open an image, PhotoLib® places it into a new image 
window. It becomes the active image. More than one image can be 

open within PhotoLib® simultaneously. 

Note - PhotoLib® maintains, at the bottom of the File menu, a list 
of the last four files you have opened. You can access any of these 

files by simply clicking on its file name. If no files are listed 
(beneath Exit), then you must use the Open command to open the 

file. Also you can use the Browser to view images under any 
directory you selected. Brief informations are given in Browser 

item.  
File Name From this list box, select the name of the file you want to open. You can either type the name of the file (with its 

entire path, if it is not in the current folder), or use the look in and Files of type selections to obtain a list of file 

names from which you can select. Double-clicking on a file name in the large list box (where both folder and file 

names are listed) will automatically open it. Note - if you simply type in the file name, be sure that the Files of 

type field correctly identifies the format of the file you want to open. Otherwise you will receive an error message 
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when PhotoLib® tries to open the file. 

Files of type In this list box, select the image format of the file you want to open. If you select All Formats, PhotoLib® uses the 

file's extension to identify its format (e.g., TIF for TIFF, PCX for ZSoft files, .BMP for bitmap files, and so forth). 

If your image file does not use standard format-identifying extensions, you must type the name of your file in the 

File Name field, then select its format from the File Type list box. Otherwise, PhotoLib® will select a format based 

on the file name extension.  

Preview Click this button to preview your image in miniature size. In preview mode, statistics and information about your 

image (e.g. image width, height and image location) will be displayed. The default state is no Preview. 

 

 
Fig.4.1-2 Open an image file 

4.1.3  Close(C) 

Use the Close command to close an active image and remove its 
window from the screen.  

Note - if you have modified an image before attempting to close it, 
PhotoLib® can issue a warning asking if you want to save it first.  
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4.1.4  Save(S)    Ctrl+S  

Use the Save command to immediately store the contents of the 
current window to its file (the file listed on the window's title bar) 
while leaving the image active in its window. If the image is in an 
untitled window, PhotoLib® will issue the Save File As dialog box. 

The Save command can be used to save your most recent changes 
to disk. It is often performed as a precautionary measure during 

lengthy or involved processes to reduce the amount of 
reprocessing that might be required in the event of a system 

failure or operational error. When you close an image and choose 
not to save its changes, PhotoLib® discards all changes made since 

the last Save operation.  

Note - the Save command always saves the contents of the entire 
window, even if there is an AOI (Area Of Interest) defined within 
it. If you need to store just the contents of an AOI, use the Copy 

To... command. 
4.1.5  Save as(A)... 

Use the Save As command to store the contents of the current 
window, to a file that you specify, in the format that you specify. 

At the end of a Save As operation, your image window will be 
associated with the new file and the new format (i.e., its title bar 

will display the new file name). See Fig 4.1-3. 

Save in: Find the folder into which you want to save the file. You 
may create a new folder using the New Folder button. 

File name: Enter the name of the file you want the image saved to. 
To specify the file's location, you can either enter its entire path 

(disk and folder), or specify its location using the Save in list box. 

Save as type: In this list box, select the format in which you want 
the image saved. It is also used to convert a single image from one 

format to another. For example, if you needed a TIFF file 
converted to PCX format, you would simply open the TIFF image, 
then use Save As command with the PCX format option to save it 
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to a new file. 

The Save As command serves several important uses beyond 
simply storing an image to a new file name (click Advanced 

button). It is also used to: 

Gray 

It is used to convert the active image's color format. If Gray checkbox is clicked, the active image (color 

image or gray level image) will be changed to 8 Bits gray level image. Otherwise you can choose to save 

active image in 24 Bits or 8 Bits. When you select to save it in 8 Bits, you can adjust image palette quality in 

Palette Quality listbox.  

8 Bits 

Save active image in 256 gray level or 256 index color. Note: - if you plan to use the image with another 

program, be sure it is compatible with the selected compression method. Not all programs support 

compressed and uncompressed format variants. 

24 Bits Save active image as a 24 bits True Color image. 

Compression 

 Save an image with different compression or quality options from those it was originally created with. For 

example, if your original TIFF file was uncompressed, you can use Save As command with the LZW 

compression option to store it in compressed form. Note - if you plan to use the image with another program, 

be sure it is compatible with the selected compression method. Not all programs support compressed and 

uncompressed format variants. 

Left_Top Use this command to encode active image from left_top to right_bottom style.  

Interlace Use this command to encode active image with interlace mode. 

Palette Quality 
If you save an image in 8 bits color mode, you can choose palette quality listed (e.g. Normal, Good, Better, 

Best). 

Transparent Use this command to encode an image in transparent mode. 

JPEG Quality 
If you save an image in JPEG format (*.jpg), you may adjust save quality in the edit box. The value range 

from 0 to 100. 

Note - Detailed information of the above academic terminologies 
can be found in the books about image processing and image 

compression or in the internet 
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Fig.4.1-3 Save image as 

Notes:：About image encoding and compression, please see the 
reference about image processing   

4.1.6 Import Photo (I) 

Use Import Photo to capture image from image import devices 
such as Scanner, Digital Camera, USB Camera or devices support 

VFW, WDM and Twain interface. 

(1)   Select Devices(E)... 
Select active import device from all devices available in the list 

box, see Fig4.1-4. 
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Fig.4.1-4 Select Input Devices 

(2)  Capture... (C)... 
A Twain interface dialog will be display in the Frame Window. If 
capture button is clicked, the image displayed in Twain window 
will be capture to the window or the database. There should be 

some setting buttons in the dialog. Help can be found in the 
specific devices manual or help menu. 

(3)  VFW Capture(V)   
A specially design window which will display video image from 
the devices. It support device with VFW (Video For Window) 

interface. See Fig.4.1-5 
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图 4.1-5 Video Window 

 

Single Capture  
Set active image displayed in the Video Window as a new image window. You can change options such as 

name, format and direction of this image window when saving it to a file. 

Timed Capture  
Click this command to capture a sequence of images from import device. You can adjust Time Interval and 

Frames To be Captured in the dialog window. See Fig. 4.1-6 

Video Capture  

Click this button to begin capturing a sequence of images to create a video file named CAPTURE.AVI that 

will be placed in the direction "C:\" by default. To end capture click again or press ESC key. Also you can 

change saved file's name and direction by choosing Save Video As... command in File menu. Make sure you 

have enough disk space before you begin to do this command. 

Video Format  
Use Video Format command to choose import device in all listed devices, and you can change Image Size 

which will be saved as Video, and you also can choose Image Format (e.g. RGB 24, RGB 16, UYVY, YUY2).

Video Source 

Control  
Use this command to adjust configurations of current selected import device. You should refer to more 

information in import device's user manual. 
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Video Preview  
If click this command, the real-time video will be displayed in the window. Otherwise it will always display 

the latest one. 

Video Compress  Select proper program existed to do video compress.  

Close Video 

Window  
Close this Video Window only. 

Exit  Exit the entire program. 

Reload  Set the magnification as the first one. 

Magnification

 

List all magnifications you specified in Sys Magnification dialog window. When select proper magnification, 

the current scale will be displayed at the bottom of the window. There exist two lines. By default, its unit is 

pixel, the longer line represent 50 pixels and the shorter one represent 5 pixels. After you define your own 

resolutions (See more in Set Resolution) and choose one of them in the list, the longer line will show 50 

pixels on the screen are equivalent to how many units as your choice, the shorter one will show 5 pixels on 

the screen are equivalent to how many units as your choice. 

 

 
Fig.4.1-6 Timed Capture 

4.1.7  Desktop (D) 

Select this option if you want to capture the entire screen, the 
same function as the PrtScr button. 

4.1.8  Open Database (E) 

When select this command, the program will display an Open 
Database dialog box as shown in Fig.4.1-7. In DB name you can 
input name and location of the database file(*.mdb) you want to 

open or use browse to indicate it. 

After open a database, you may get some useful information, 
including PHOTO_NO, TYPE, TOPIC, USAGE, ADDRESS, 

OWNER, DATA, PHOTO_PATH, IMAGE_SUM, 
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CD_VOLUME and REMARK. You can Edit these options and 
Delete the current chosen database (See Fig 4.1-8), you can also 

create a database with New command (see Fig.4.1-9). 

 
Fig.4.1-7 Open Data Base 
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Fig.4.1-8 Edit Data Base record 
 

 
图 4.1-9 Add Record 

4.1.9  Disconnect Database (S) 

Disconnect from an open database file. 
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4.1.10  Print (P)...  Ctrl+P  

Use the Print command to print one or more copies of the current 
image to the selected output device. PhotoLib®'s Print command 
lets you take full advantage of your printer's capabilities. If your 

printer has built-in halfton or color dithering capabilities, you 
can use them. Or, you can instruct PhotoLib® to perform these 

processes before sending the image to the device. 

The Print command also has facilities that let you adjust the size 
and position of your image on the printed page. 

4.1.11  Print Preview (V)�   

Use the Print Preview command to see the real-time effect of 
printer without printing it out actually. 

4.1.12  Print Setup (U)... 

Click this button to access the setup panel for the printer you 
have selected. PhotoLib® will present the standard setup panel for 
your particular printer (this is the same panel you would receive 
if you were setting up your printer from the Windows Control 
Panel). Change your printer's setup to suit your needs, click its 

OK button to return. 
4.1.13  Send (D)... 

Use the Send command to send text and images to one or more 
people using Internet or Microsoft e-mail. You can compose a 

message and include one of the active images as a file attachment. 
4.1.14  Exit (X) 

  Exit PhotoLib。 

4.2  Edit Menu 

4.2.1  Undo Ctrl+Z  

Most operations can be undone (<Ctrl>+<Z>) if you make a 
mistake. Alternatively, you can restore all or part of an image to 

its last saved version. 
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4.2.2  Redo Ctrl+Y  

Use the Redo command (<Ctrl>+<Y>) to undo the most recent 
Undo operation. 

4.2.3  Cut(T) Ctrl+X  

Use the Cut command (<Ctrl> + <X>) to copy the contents of the 
selected AOI to the Windows Clipboard and replace the AOI in 

the image with the background color selected in the Paint Box. If 
no AOI is active, PhotoLib® copies the entire active image to the 
Clipboard and replaces it with the background color in the Paint 
Box. The Cut operation changes the contents of the image in the 
active window (i.e. Cut deletes the AOI pixels). Any data already 

existing on the Clipboard will be replaced.  

The data copied to the Clipboard can be pasted into the active 
window or into another open window using the Paste command. 
You can also create a new window directly from the Clipboard 

contents using the Paste As a New File command. 

4.2.4  Copy(C) Ctrl+C  

Use the Copy command (<Ctrl> +<C>) to copy the contents of the 
selected AOI to the Window Clipboard. If no AOI is active, 

PhotoLib® copies the entire active image to the Clipboard. Copy 
will not change the contents of the image in the active window (i.e., 

copy does not delete the copied pixels). Any data already 
existed on the Clipboard will be replaced by the new one. 

The copied data can be pasted into the active window or into 
another open window using the Paste command. You can also 

create a new window directly from the Clipboard contents using 
the Paste As a New File command. 

4.2.5  Paste(P)  Ctrl+V  

Use the Paste command (<Ctrl> + <V>) to place the contents of 
the Windows Clipboard into the active image. You would use 

Paste to transfer part of one image into another.  
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Before you can execute the Paste command, you must have 
somehow placed valid image data on the Windows Clipboard (see 

the Copy command). If there are no data on the Clipboard, the 
Paste command will not be active. Image data can be pasted into 

any image type that PhotoLib® supports.  

PhotoLib® will accept image data from other applications via the 
Clipboard as long as it is in Windows DIB format. If you attempt 

to Paste non-image data (e.g., text or spreadsheet data) to an 
image window, after you first perform Copy operation, the Paste 

will still in Grayed or Disable status and thus you will Paste 
nothing. 

When you select the Paste command, PhotoLib® will initially 
position the Clipboard data in the upper-left corner of the 

currently active window. Put your cursor over the Clipboard data. 
Your cursor will appear as a 4-way arrow and will allow you to 
drag the Clipboard data to the desired position you want. When 

you are happy with its position, click the right mouse button 
permanently set the Clipboard data into the image. The 

Clipboard pixels will overlay those at the specified position.  

If the Clipboard image is larger than the destination image, it ask 
you whether to enlarge the background image or not. Please 

make sure to select the right image before confirming the Paste 
operation (left-mouse click). 

4.2.6  Selective Paste (S)� 

Use Selective Paste command to place the contents of the 
Windows Clipboard into a new image, which become the active 
image. When to do this, you can choose the format of the new 

image from the following options (See Fig.4.2-1): 

DIB Device Independent Bitmap 

DDB Device Dependent Bitmap 

Palette Index Bitmap 
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Fig. 4.2-1 Selective Paste 

4.2.7  Paste As a New File (N) 

Use the Paste As a New File command to place the contents of the 
Windows Clipboard into a new image, which becomes the active 

image.  

Before you can execute the Paste As a New File command, you 
must have somehow placed valid image data on the Windows 

Clipboard (see the Copy command). If there are no data on the 
Clipboard, the Paste command will not be active.  

The class of the new image will be the same as that of the original 
image. PhotoLib® will accept image data from other applications 

via the Clipboard as long as it is in Windows bitmap (BMP), 
Tagged Image File Format (TIF), Device Independent Bitmap 

(DIB) or Windows' Picture form. If you attempt to Paste 
non-image data (e.g., text or spreadsheet data) to an image 

window, you will receive an error message.  
4.2.8 Delete (D)  Del 

Use Delete command (<Del>) to set active rectangular AOI area 
into background color selected in the Paint Box, if there is no AOI 

area exist the whole image will be deleted. 
4.2.9  Copy To (O)� 

Copy entire active image to a disk file. When to do this, you must 
enter file name and location and also you can select image format 

from following selection in file save type list: 

Monochromatic Bitmap; 16 Bits Bitmap; 256 Color Bitmap; 24 
Bits Bitmap. 
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4.2.10  Paste From (F)� 

Paste an image from a file in disk. When click this button will 
display Open dialog window to let you choose proper file in 
proper location. If the image file is larger than active image, 

PhotoLib® will issue a warning asking if you want to enlarge the 
image. 

4.3  Image Menu 
4.3.1  Select (S) 

You can use selection borders to select pixels. When you Select 
pixels, you are selecting resolution dependent on information of 

the image. 

When you click on the Select command, you will have following 
options: 

(1) Select All (A) Ctrl+A  
Select all pixels on a layer within the canvas boundaries 

(2) Rectangle Select (S)   
Select a rectangle area of the image pixel. When Rectangle Select 
command is active, A "+" shape cursor will be appeared in the 
image area, using left mouse button to determine the first point, 
then keep the left mouse button down and move the mouse, after 
the left mouse button is up, a rectangle area will be appeared on 

the image area. This region is the Rectangle Selected region. If the 
user put the mouse button on the selected area, then a Move shape 
mouse cursor will appeared, then the user can move the rectangle 

to where ever he want. 

(3) Move (M)   
Move the mouser cursor inside the selection area, and drag the 

selection area to a new position, then use Merge Float Wnd 
command to merge images. When this command is active, the 

mouse cursor will change to Move shape. See the Rectangle 
Selection to learn how to get selection area. 
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(4) Deselect (D) 
Deselect selected area on the image (including the entire image 

area). 

(5) Make Selection (P)... 
User can use the Make Selection command to make an exact 

selection area. A Rectangle Selection made selection area must be 
made first, then one can evoke the Make Selection dialog and 

make fine selection.  

The dialog will show current image resolution in both directions 
(See 4.3-1). One can also modify the image resolution in this 

dialog using Modify... to Set Image Resolution. 

 
Fig.4.3-1 Set rectangle size for selection 

 
Unit Display unit of the image can be selected first. 

TLX The X value of the selection area's topleft point. 

TLY The Y value of the selection area's topleft point. 

H  The selection area height 

W The selection area width 

(6) Merge Float Wnd Ctrl+M 
When there exists a float window on the current active window, 
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use Merge Float Wnd command can merge the float window and 
current image window into one image window 

4.3.2 Adjust (A) 

When you click on the Adjust command, you will receive a menu 
from which you can choose the Adjust operation you want to 

perform as following: 

(1) Color (R)... 
The Color command changes the overall mixture of colors in an 
image for generalized color correction. The Color command will 

evoke a dialog is shown in Fig.4.3-2. 

 
Fig.4.3-2 Image Color Adjust 

There are four color modules exist: 

RGB 

PhotoLib®'s RGB mode uses the RGB model, assigning an intensity value to each pixel ranging from 0 (black) to 255 

(white) for each of the RGB components in a color image. For example, a bright red color might have a R value of 246, 

a G value of 20, and a B value of 50. When the values of all three components are equal, the result is a shade of neutral 

gray. When the value of all components is 255, the result is pure white; when the value is 0, pure black. 

RGB images use three colors, or channels, to reproduce up to 16.7 million colors on-screen; the three channels translate 

to 24 (8 x 3) bits of color information per pixel. (In 16-bit-per-channel images, this translates to 48 bits per pixel, with the 

ability to reproduce many more colors.) In addition to being the default mode for new PhotoLib® images, the RGB model 

is used by computer monitors to display colors. This means that when working in color modes other than RGB, such as 

CMYK, PhotoLib® uses RGB mode for display on-screen.  

Although RGB is a standard color model, the exact range of colors represented can vary, depending on the application or 

display device. PhotoLib®'s RGB mode varies according to the working space setting that you have specified in the Color 

Settings dialog box.  
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CMYK 

The CMYK model is based on the light-absorbing quality of ink printed on paper. As white light strikes translucent inks, 

certain visible wavelengths are absorbed while others are reflected back to your eyes.  

In theory, pure cyan (C), magenta (M), and yellow (Y) pigments should combine to absorb all light and produce black. For 

this reason these colors are called subtractive colors. Because all printing inks contain some impurities, these three inks 

actually produce a muddy brown and must be combined with black (K) ink to produce a true black. (K is used instead of B 

to avoid confusion with blue.) Combining these inks to reproduce color is called four-color process printing. 

The subtractive (CMY) and additive (RGB) colors are complementary colors. Each pair of subtractive colors creates an 

additive color, and vice versa. 

HSI 

Based on the human perception of color, the HSI model describes three fundamental characteristics of color: 

Hue is the color reflected from or transmitted through an object. It is measured as a location on the standard color wheel, 

expressed as a degree between 0° and 360°. In common use, hue is identified by the name of the color such as red, orange, 

or green.  

Saturation, sometimes called chroma, is the strength or purity of the color. Saturation represents the amount of gray in 

proportion to the hue, measured as a percentage from 0% (gray) to 100% (fully saturated). On the standard color wheel, 

saturation increases from the center to the edge.  

Intensity is the relative lightness or darkness of the color, usually measured as a percentage from 0% (black) to 100% 

(white). 

Although you can use the HSI model in PhotoLib® to define a color in the Color palette or Color Picker dialog box, there 

is no HSI mode available for creating and editing images. 

HLS 

The HLS model is very similar to the HSI color model. The main difference between the two is the calculation used to 

produce the brightness value. In the HSI model, a pixel's brightness (I) is derived from the mean of its three (R, G and B) 

color values. In the HLS model, a pixel's brightness (L) is determined from the mean of the minimum and maximum value 

of its three color values. 

Preview Select this checkbox can display real-time effect when you change sliderbar. 

 

The values beside the slide bar show the color changes for variant 
color channels. For RGB channel values can range from -100 to 

+100. For CMYK channel values can range from -100 to +100.For 
HSI channel H value can range from -180 to 180,S value can 

range from -275 to 275,I value can range from -442 to 442.For 
HLS channel, H value can range from -180 to 180, L value can 

range from -100 to 100, S value can range from -100 to 100. 
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(2) Brightness/Contrast... Shift+B 

 
Fig.4.3-3 Contrast/brightness adjust 

 

The Brightness/Contrast command (<Shift>+<B>) lets you make 
simple adjustments to the tonal range of an image. This command 

makes the same adjustment to every pixel in the image. The 
Brightness/Contrast... command does not work with individual 

channels and is not recommended for high-end output, because it 
can result in a loss of detail in the image. Its dialog is shown in 

Fig.4.3-3. 
Preview Select this checkbox can display real-time effect when you change slide bar 

 

Dragging the slide bar to the left decreases the level and to the 
right increases it. The number at the right of each slider value 

displays the brightness or contrast value. Values can range from 
-100 to +100. 

(3) Gamma... Shift+G 
Gamma measures the brightness of middle tone values produced 
by a device (often a monitor). A higher gamma value yields an 

overall darker image. Dragging the slide bar to the left decreases 
the level and to the right increases it. Values can range from 0 to 

3.0. The gamma adjust dialog is shown in Fig.4.3-4。 
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Fig.4.3-4 Gamma Adjustment 

 
Preview Select this checkbox can display real-time effect when you change slide bar 

(4) HMS... Shift+H 
Use HMS... command to adjust the H (High Light), M (Middle 
tone) and  S (Shadow) part of the image. Each part's value can 
range from -100 to 100. This command is only available for 24 

bits True Color image. The HMS adjust dialog is shown in 
Fig.4.3-5 

 
图 4.3-5 HL/M/S Adjust 

Preview Select this checkbox can display real-time effect when you change slide bar. 

 
(5) Curve(C)... 

Curve dialog box lets you adjust the entire tonal range of an 
image. But instead of making adjustments using only three 

variables (highlights, shadows, middle tones), with Curve you can 
adjust any point along a 0-255 scale while keeping up to 15 other 

values constant. You can also use Curve to make precise 
adjustments to individual color channels in an image. 
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The horizontal axis of the graph represents the original intensity 
values of the pixels (Input levels); the vertical axis represents the 
new color values (Output levels). In the default diagonal line, all 

pixels have identical Input and Output values. The curve adjust is 
shown in Fig.4.3-6. 

Curves Drag the curve until the image looks the way you want it 

Pencil Select the pencil at the bottom of the dialog box, and drag to draw a new arbitrary curve. 

Channel To adjust the color balance of the image, choose the channel (R, G or B) you want to adjust from the Channel 

button. To select RGB channels at the same time, you can click the white button which is located on the left of R 

(Red), G (Green) and B (Blue) buttons. 

 
Fig.4.3-6 Curve adjust dialog 

(6) Auto Level 
The Auto Level command moves the level sliders automatically to 

set highlights and shadows. It defines the lightest and darkest 
pixels in each color channel as white and black and then 

redistributes intermediate pixel values proportionately. Because 
Auto Level adjusts each color channel individually, it may remove 

or introduce color casts. 

By default, this feature clips the white and black pixels by 
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0.5%--that is, it ignores the first 0.5% of either extreme when 
identifying the lightest and darkest pixels in the image. You can 

change this default setting at menu Set up -> Auto Clipping Range. 
This ensures that white and black values are based on 

representative rather than extreme pixel values.  

Auto Level gives good results when an image with an average 
distribution of pixel values needs a simple contrast adjustment or 
when an image has an overall color cast. However, adjusting the 

Curves controls manually is more precise. 

See Auto Contrast for another auto adjust command. 

(7) Auto Contrast 
The Auto Contrast command adjusts the overall contrast and 

mixture of colors in an RGB image automatically. Because it does 
not adjust channels individually, Auto Contrast does not introduce 

or remove color casts. It maps the lightest and darkest pixels in 
the image to white and black, which makes high lights appear 

lighter and shadows appear darker.  

When identifying the lightest and darkest pixels in an image, Auto 
Contrast clips the white and black pixels by 0.5%--that is, it 

ignores the first 0.5% of either extreme. You can change this 
default setting at menu Set up -> Auto Clipping Range. This 

ensures that white and black values are based on representative 
rather than extreme pixel values. 

Auto Contrast can improve the appearance of many photographic 
or continuous-tone images. It does not improve flat-color images. 

See Auto Levelst for another auto adjust command. 

(8) Color Bits (B)... 
Use Color Bits command to adjust active image's bits count. You 

can choose 24 bits、8 bits、4 bits or 1 bit to represent one pixel. Its 
dialog is show in Fig.4.3-7. PhotoLib is for scientific image 

processing and analysis, 24 bits and 8 bits are supported 
currently 
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Fig.4.3-7 Change Color bits 

(9) Color-->Gray (G)... 
Use Color -> Gray command to change color image (True Color 

image or index color image ) to 8 bits gray scale image. If the 
image is true color image, change to gray scale will evoke the 

display of the palette if the Paint Box is visible. If the image is an 
indexed color image, then color in the Palette Box will also change 

to relative gray color 

(10) Color Separation 
Use Color Separation command to separate a special color 

channel from a color image. You can choose one of Red, Green or 
Blue color to separate. For every pixel, if you select Red color to 
separate, then only red channel has been kept, the image green 

and blue information will be discarded. 

See Color Filter for another color operation. 

(11) Color Filter 
Use Color Filter command to filter a special color channel from a 
color image. You can choose one of Red, Green or Blue color to 
filter. For every pixel, if you select Red color to filter, then only 

red channel will be discarded, green and blue information will be 
remained. 

See Color Separation for another color operation 

(12) Negative 
Use the Negative command to instruct PhotoLib® to reverse the 

pixel values for your active image without going through the 
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lookup table. 

(13) Contrast/Brightness Tool  
Use Contrast/Brightness command to adjust image's Brightness or 

Contrast. Moving left-button-down mouse horizontally will 
change image's Brightness, while moving left-button-down mouse 

vertically will change image's Contrast.  The command effect 
relate not only to mouse move distance but also to the value set in 

Space Set dialog. 
4.3.3  Rotate(R) 

Rotate 90 PhotoLib® rotates the image counterclockwise by a quarter-turn. 

Rotate 180 
PhotoLib® creates a mirror image of the original image in the application area, so that the top right corner of 

the original image becomes the bottom left corner, and the top left corner of the original image is now the 

bottom right corner. 

Rotate 270 PhotoLib® Rotate the image counterclockwise by 270 degrees. 

Rotate Arbitrary 

Arbitrary to rotate the image by the angle you specify. If you choose this option, enter an angle between 0 and 

360 degrees in the angle text box, then select C and CC to rotate clockwise or counterclockwise. Other area of 

image will be filled in with background color, which can be selected in Paint Box with sample tool (See 

Fig.4.3-8). 

Horizontal 

Mirror 
PhotoLib® reverses the image in the application area, so that the top right corner of the original image is now 

the top left, and the top left corner of the original image is now the top right corner. 

Vertical Mirror 
PhotoLib® reverses the position of the image in the application area, so that the top right corner of the original 

image is now the bottom right corner, and the top left corner of the original image is now the bottom left corner.

 

 
Fig4.3-8 Image Rotation 

4.3.4 Crop (R) 

Crop command is the process of removing portions of an image to 
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create focus or strengthen the composition you select. Removed 
part of the image will be filled with white color. Before you do the 
Crop command, you must select the part of the image you want to 

keep using Rectangle Select command to select a region you are 
interested in. 

4.3.5 Scale (L)... 

Use the Scale command to change your image at a specified size. 
This command actually changes spatial resolution by adding 
(replicating) or removing (decimating) pixels to achieve the 

specified dimensions (see Fig.4.3-9). 

 
Fig.4.3-9 Image Scale Operation  

Width The scaled new image width 

Height The scaled new image height 

Units  
From this group box, select the unit of measure (Cm, Inch or Pixel) you want the Width and Height 

measurements expressed as. 

Constrain 

Proportions. 

To maintain the current proportions of pixel width to pixel height, select Constrain Proportions. This option 

automatically updates the width as you change the height, and vice versa. Otherwise, unselect Constrain 

Proportions check box. 

4.3.6  Canvas Size(V)... 

Use Canvas Size command lets you add or remove work space 
around an existing image. You can crop an image by decreasing 

the canvas area. Added canvas appears in the same color or 
transparency as the background (See Fig.4.3-10) 
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Fig.4.3-10 Canvas Size Adjust 

 

Width: New image width including the image width and the edge. 

Height: New image height including the image height and the 
edge. 

Units: From this group box, select the unit of measure (Cm ,Inch 
or Pixel) you want the Width and Height measurements 

expressed as. 

Constrain Proportions: To maintain the current proportions of 
pixel width to pixel height, select Constrain Proportions. This 

option automatically updates the width as you change the height, 
and vice versa. Otherwise, unselect Constrain Proportions check 

box. 

Photo Location in the Canvas: Click a square to indicate where to 
position the existing image on the new canvas. 

4.3.7  Picker (P)   

Picker tool can be used to pick out specified pixel intensity value 
(for graylevel image) or color value (for true color image) in the 

image by pointing it out with moving mouse. The value can be set 
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as foreground or background color. 

4.3.8  Erase(E)   

Erase tool make you replace pixels with background color as you 
drag through them. 

4.3.9  Fill(F)   

Fill tool fills adjacent pixels that are similar in color value to the 
pixels you click. 

4.3.10  Zoom Tool(Z)   

Click left button of mouse on image will enlarge the image to the 
larger scale and click right button of mouse on image will reduce 
the image to the smaller scale. The scales are listed in Toolbar's 

Quick Room 

4.3.11  Panning(N)   

If the image's actual size is larger than that of frame window, use 
Panning command to move image to display specified area. It's 

function is similar to scroll bar but more convenience. 

4.4  Layer Menu 

4.4.1 Select Object (S)   

After drawing or painting on the specific layer  (not the 
background layer), use Select Object command to select interested 

object. You can select one object by clicking on it, or select a 
group of objects by including them in a rectangle area (just like 

Rectangle Select operation). See more information of Selected 
Object by choosing Measure->Measure command.  

4.4.2 Point (P)   

Draw a Point at the place where you click mouse left button on 
the specified layer. To set the Point characteristic, one can use 

Select Object tool and double click the Point drawn, then a dialog 
will appear as shown in Fig.4.4-1. The detail information can be 
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found in the Setup->Drawing Defaults. 

 
Fig.4.4-1 Point label 

4.4.3  Line(L)   

Draw a Line between the two points after one select the specified 
layer. Using Select Object tool and double click on the Line drawn, 

a Line characteristic setup dialog will be shown as in Fig.4.4-2. 
The detailed information about Line label setup can be found in 

the Setup->Drawing Defaults. 

 
Fig.4.4-2 Line Label 

4.4.4 Angle (A)   

Draw an Angle when click three points on the specified layer, the 
second one will be the vertex. Using Select Object tool and double 
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click on the Angle drawn, an Angle characteristic setup dialog will 
be shown as in Fig.4.4-3. The detail about angle label setup can be 

found in the Setup->Drawing Defaults.  

 
Fig.4.4-3 Angle Label 

4.4.5 Rectangle(R)   

Draw a Rectangle area on the specified layer. Using Select Object 
tool and double click on the Rectangle drawn, a Rectangle 

characteristic setup dialog will be shown as in Fig.4.4-4. The 
detail about rectangle label setup can be found in the 

Setup->Drawing Defaults. 

 
Fig.4.4-4 Rectangle Label 
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4.4.6  Round Rectangle (O)   

Draw a Round Rectangle area on the specified layer. Using Select 
Object tool and double click on the Round Rectangle drawn, a 

Round Rectangle characteristic setup dialog will be shown as in 
Fig.4.4-5. The detail about round rectangle label setup can be 

found in the Setup->Drawing Defaults. 

 
Fig.4.4-5 Round Rectangle Label 

4.4.7  Ellipse(E)   

 Draw an Ellipse area on the specified layer. Using Select Object 
tool and double click on the Ellipse drawn, an Ellipse 

characteristic setup dialog will be shown as in Fig.4.4-6. The 
detail about ellipse label setup can be found in the 

Setup->Drawing Defaults. 
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Fig.4.4-6 Ellipse Label 

4.4.8  Polygon(N)   

Draw a Polygon area on the specified layer by clicking a sequence 
of points. Using Select Object tool and double click on the Polygon 
drawn, a Polygon characteristic setup dialog will be shown as in 

Fig.4.4-7. The detail about polygon label setup can be found in the 
Setup->Drawing Defaults. 

 
Fig.4.4-7  Polygon Label 

4.4.9  Text(T)   

Draw a rectangle area in which you can enter any interested Text. 
Using Select Object tool and double click on the Text rectangle 
drawn, a Text characteristic setup dialog will be shown as in 

Fig.4.4-8. The detail about text rectangle label setup can be found 
in the Setup->Drawing Defaults.  
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Fig.4.4-8 Text Label 

4.4.10  Up Most(U)   

Change the selected object's relative position to the Up Most of 
all. 

4.4.11  Down Most(D)   

Change the selected object's relative position to the Down Most of 
all. 

4.4.12  Move Up  

Change the selected object's relative position to the upper place of 
the two 

4.4.13  Move Down  

Change the selected object's relative position to the lower place of 
the two. 

 
Fig.4.4-9 Relative Position of Different Label 
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4.5  Process Menu  
4.5.1  Filters(F)... 

Use Filters command to apply one of PhotoLib®'s numerous 
Filters to the active image. Filters operations reduce or boost the 

rate of brightness change in an image. If you are not familiar with 
the process and effects of filtering, you might want to review some 

discussion about the Spatial Filtering. PhotoLib® provides an 
extensive set of convolution and non convolution (morphological) 
Filters. You can also create your own filtering kernels and apply 

them with the Filters command.  

When you select the Filters command, the Filter tab dialog is 
opened. Each group of Filters has its own property sheet or tab, 

where you select the type and size of filter you want to use. 
Filtered results are almost always written to the active image. 
You may use the Undo command if you want to remove the 

effects of a Filter you have applied.  

Clicking on the Filters command displays the Filters dialog box 
and one of several tab dialog pages. 

Enhancement Filters tab dialog; Edge Filters tab dialog; 
Morphological Filters tab dialog; Kernels tab dialog 

(1) Image Enhancement 

The property page has the following Filters (shown in Fig.4.5-1)。 
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Fig.4.5-1 Image Enhancement Property Page 

 

Select Enhancement (also known as convolution) filters from this 
tab.  

LoPass  

 Select this filter if you want to soften an image by eliminating high-frequency information (this has the effect of 

blurring sharp edges). The LoPass filter replaces the center pixel with the mean value in its neighborhood. The LoPass 

filter can also be used to remove noise.  

HiPass 

 Select this filter if you want to enhance high-frequency information. The HiPass filter replaces the center pixel with a 

convolved value that significantly increases its contrast from its neighbors. The HiPass filter leaves only elements of 

high contrast. 

Gauss 

 Use this filter to soften an image by eliminating high-frequency information using a Gauss function. This has the effect 

of blurring sharp edges. The operation of the Gauss filter is similar to the LoPass filter, but it degrades the image less 

than the LoPass filter. 

Higauss 

 Use this filter when you want to enhance fine details. Its operation is similar to the unsharp masking technique (see the 

Sharpen filter), but it introduces less noise in the process. It uses a Gaussian curve type of kernel. Available in 7x7 and 

9x9 kernel sizes. 

Local  This filter is used to enhance pixel contrast based on the histogram of the local neighborhood. (See options below.) 
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Equalize 

Sharpen 
 Select this filter if you want to enhance fine detail, or refocus an image that is blurred. The Sharpen filter sharpens the 

image using the "unsharp masking technique." 

Median 
 Select this filter if you want to remove impulse noise from an image. The Median filter replaces the center pixel with 

the median value in its neighborhood. It will also blur the image. 

Rank 

 Select this filter if you want to remove impulse noise from an image. The pixels in the kernel are ranked by order of 

intensity, and the pixel in that range at the rank percentage is chosen for comparison. For example, in a 5x5 kernel, 

there are 25 pixels. A rank percentage of 95% would choose the second-brightest pixel for comparison. If the 

differences between the selected pixel and the center pixel is greater than the threshold value, the Rank filter replaces 

the center pixel with the selected pixel. 

Options:  
1. If you have selected one of the Enhancement filters, the options 

will relate to kernel size and filtering strength. The following 
options will be presented:  

3 x 3  Select this button to use the 3 x 3 kernel size. A small kernel produces a more subtle filtering effect. 

5 x 5  Select this button to use the 5 x 5 kernel size. 

7 x 7  Select this button to use the 7 x 7 kernel size. A large kernel produces a more extreme filtering effect. 

Passes 

 Enter the number of times you want the filter applied to your image. When a filter is applied multiple times, its 

effect is amplified by each pass. An image that has been softened by one pass of the LoPass filter, will be softened 

further by a second pass. 

Strength 

 Enter a value from 1 - 10 that reflects how much of the filtering effect you want applied to the image. A value of 10 

specifies that you want the full strength (100%) of the filtered result applied to each pixel. Values less than 10 cut 

the full weight of the filter - a value of 1 indicates that only 10% of the difference between the filtered pixel value 

and the original pixel value should be applied, a value of 2 indicates that 20% of the difference should be applied, 

and so forth. 

Rank 

 This value specifies which pixel in the sorted array will be used to replace the center pixel. Pixels in the array will 

be sorted in ascending order. The pixels are indexed from 0 to Kernel Size x Kernel Size - 1. Pixel index 0 

corresponds to the lowest pixel value. The Rank will be specified in terms of a percentage of the indexes ( Kernel 

Size x Kernel Size - 1). A 50% Rank means the middle of the array. 0% rank means the lowest index (lowest gray 

value), and 100% rank means the highest index (highest gray value). 

2. If you have selected Local Equalization filters, the options will 
relate to the histogram equalization. Local Histogram 

Equalization modifies the contrast of an image based on the pixel 
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values in a small window surrounding each pixel (See Fig.4.5-2). 

 Window 

Image pixel statistics (min, max, histogram, mean, standard deviation, etc.) will be calculated on a small window 

of the image. These measurements are then used to derive the local contrast for that area of the image. In short, 

an area of Window x Window around each pixel is all that is considered when modifying the intensities in the 

image. Larger windows produce smoother results, while small windows more closely track small details. 

Best Fit 
Use the Best Fit command to optimize the values for your particular image. The results are achieved by stretching 

the local histogram to maximize contrast between the brightest and darkest pixels in the local window region. 

Linear 
This option distributes the histogram equally across the intensity scale. This function produces a high contrast 

image with the highest possible dynamic range. 

Logarithmic 

This option concentrates the histogram at the low end of the scale. This function produces a high contrast image 

with little dynamic image. It will tend to darken the image overall. Useful for increasing the contrast in a very 

light image. 

Exponential 

This option concentrates the histogram at the high end of the scale. This function produces a high contrast image 

with little dynamic image. It will tend to lighten the image overall. Useful for increasing the contrast in a very 

dark image. 

 

 
Fig.4.5-2 Filters－Image Enhancement 
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(2) Edge Enhancement 

This property page has following filters(See Fig.4.5-3)。 

 
Fig.4.5-3Filter－Edge Enhancement 

 

Sobel  
 Select this filter if you want to enhance just the principal edges in an image. The Sobel applies a mathematical 

formula to a 3 x 3 neighborhood to locate and highlight its edges.  

 Roberts 

 Select this filter if you want to enhance fine edges in an image. The Roberts filter is not a convolution filter. It 

applies a mathematical formula upon a 4 x 4 neighborhood to produce its effect. The upper left pixel in the 

neighborhood is the one replaced. 

 Sculpt  Use this filter to apply a sculpted effect to the image. 

 Horizontal  User this filter to detect and emphasize horizontal edges. 

 Vertical  Use this filter to detect and emphasize vertical edges. 

 

Options:  
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1. If you have selected one of the Edge filters, the options will 
relate to kernel size and filtering strength. The following options 

will be presented: 

3 x 3   Select this button to use the 3 x 3 kernel size. A small 
kernel produces a more subtle filtering effect. 

5 x 5   Select this button to use the 5 x 5 kernel size. 

7 x 7   Select this button to use the 7 x 7 kernel size. A large 
kernel produces a more extreme filtering effect. 

◆ 
Passes  

  Enter the number of times you want the filter applied 
to your image. When a filter is applied multiple times, 
its effect is amplified by each pass. An image that has 
been softened by one pass of the LoPass filter, will be 

softened further by a second pass.  

◆ 
Strength 

  Enter a value from 1 - 10 that reflects how much of 
the filtering effect you want applied to the image. A 
value of 10 specifies that you want the full strength 
(100%) of the filtered result applied to each pixel. 

Values less than 10 cut the full weight of the filter - a 
value of 1 indicates that only 10% of the difference 

between the filtered pixel value and the original pixel 
value should be applied, a value of 2 indicates that 20% 

of the difference should be applied, and so forth.  

 

2. If you have selected Sobel, Phase or Roberts, no options are 
available. 

 (3) Morphological 

This property page has following filters(see Fig.4.5-4) 
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Fig.4.5-4Filters－Morphological 

 

 Erode 
Select this morphological filter if you want to modify the size of objects in your image. The Erode filter erodes the 

edges of bright objects, and enlarges dark ones. 

 Dilate  
Select this morphological filter if you want to modify the size of objects in your image. The Dilation filter dilates 

bright objects, and erodes dark ones.  

 Open  

Select this morphological filter if you want to modify the shape of objects in your image. Assuming your image 

contains bright objects on a dark field, the Open filter will smooth object contours, separate narrowly connected 

objects, and remove small dark holes.  

 Close  

Select this morphological filter if you want to modify the shape of objects in your image. Assuming your image 

contains bright objects on a dark field, the Close filter will fill gaps and enlarge protrusions to connect objects 

that are close together.  

 Tophat 

Use this filter to detect and emphasize points, or grains, that are brighter than the background. Available in 3 

kernel sizes; click the radio button indicating the kernel size that most closely matches the size of the grains you 

want to detect. 

 Well 

Use this filter to detect and emphasize points, or grains, that are darker than the background. Available in 3 

kernel sizes; click the radio button indicating the kernel size that most closely matches the size of the grains you 

want to detect. 
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Options: 
1. If you have selected Erode, Dilate, Open, or Close filters, the 

options will relate to kernel size and shape. The following options 
will be presented: 

2 x 2 Square  Select this button to use the 2 x 2 square kernel configuration. 

3 x 1 Row   Select this button to use the 3 x 1 row kernel configuration.  

1 x 3 Column   Select this button to use the 1 x 3 column kernel configuration.  

3 x 3 Cross   Select this button to use the 3 x 3 cross kernel configuration.  

5 x 5 Circle   Select this button to use the 5 x 5 circular kernel configuration.  

7 x 7 Circle  
 Select this button to use the 7 x 7 circular kernel configuration. This is a two-pass filter, accomplished using a 

5 x 5 circle followed by a 3 x 3 cross.  

11 x 11 Circle  
 Select this button to use the 11 x 11 circular kernel configuration. This is a three-pass filter, accomplished 

using a 5 x 5 circle followed by another 5 x 5 circle, followed by a 3 x 3 cross.  

Passes  Select the number of times you want PhotoLib® to iterate the filter. 

Note - The circular kernels are especially effective on round 
objects (cells, grains and so on) because their circular 

configuration preserves the circular shape of your objects better 
than square configurations. 

 

2. If you have selected the Tophat, Well or Gradient filter, the 
options will relate to kernel size and shape. The following options 

will be presented: 

 3 x 3  Select this button to use the 3 x 3 square kernel configuration. 

 5 x 5  Select this button to use the 5 x 5 square kernel configuration. 

 7 x 7  Select this button to use the 7 x 7 square kernel configuration. 

 
3. If you have selected the Watershed, Thinning or Distance filter, 
this options will has relation with threshold value. The following 
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options will be presented: 

Threshold 

 Enter a percentage value from 1 - 100 that specifies the intensity value you want PhotoLib® to use for binarizing the 

image. For example, a Threshold of 50% on a Gray Scale image would set all values ≤127 to 0 (black) and all 

values ≥128 to the maximum value for that image class (white). 

 (4) Operation Kernels 
The Kernel tab dialog page allows you to edit the kernel files for 

the morphological and convolution filters.  

Note - The HiPass, LoPass, Laplace and Unsharp Kernel files are 
used by the HiPass, LoPass, Laplacian and Sharpen options listed 

in the Enhancement Filters tab dialog window (i.e., there is no 
difference between selecting one of these kernel files and selecting 

its option button in the Filter window -- the two methods 
ultimately do the same thing). Because these kernel files are 

essential to the operation of these filtering options, they must not 
be deleted or renamed. 

Filter Type  Click this button to modify the kernel for a selected filter type, either convolution or morphological filters. 

Edit   Click this button to modify the selected filter kernel using the Edit Kernel dialog box.  

Name  
 This list box contains the name of the selected kernel file. If you want to save the modified kernel file to the same file, 

leave it as is. If you want to save the file to a new location, enter the new filename here.  

Kernel Size 

 Click the spin buttons or enter the number to change the size of the kernel. Either direction may take into account 

from one to nine pixels. As you modify the Kernel Size, the shape of the kernel representation changes accordingly. In 

the center of the dialog box, there are white boxes containing coefficients that will be multiplied with each pixel that 

will be taken into account by the filter kernel. You can change any coefficient by clicking on it to select it, then 

changing it as you will. 

Fill 

 Click this button to fill every element of the kernel with a particular value. The Fill Kernel dialog box appears. You 

may enter a value between 0 and 10. Using the Fill button is useful for setting all coefficients to the same value. You 

may then change the coefficients that require a different value. 

Offset 

 The pixel whose value is being changed is usually the center-most pixel. You may, however, designate any pixel you 

want. PhotoLib® signals the pixel to be changed by putting a box around it. Use the X and Y Offset spin buttons to do 

so. 

New  Click this button in the Kernels tab dialog to create a new filter kernel. The Edit Kernel dialog box appears. 

This dialog box functions in the same way as the dialog box for 
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editing (described above), with the exception that you must 
provide the file name for the new kernel file. 

Note - You may choose a different path for your kernel file, but 
PhotoLib® will not list it when you invoke the Filter dialog box. 

Observe that the above dialog box represents a configuration for 
a new morphological filter kernel (Kernel Sum are not 

represented). 

Delete   Click this button in the Kernels tab dialog to delete the selected filter kernel file. 

Options   The choices in this group box will vary depending upon the kind of filter you have selected. 

 

 
Fig.4.5-5 Filters－Operation Kernels 

4.5.2  Arithmetic(A)... 

Use the Arithmetic command to perform arithmetic and logic 
operations upon the active image, sequence, or AOI. Such 
operations can be performed between two images (such as 

subtracting a "Hi Pass" filtered image from an original image to 
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emphasize high-contrast elements), or between an image and a 
constant value (such as "ANDing" an image with 240 to retain 
only the 4 most significant bits of information). See Fig.4.5-7. 

The Arithmetic command can be used on both monochrome and 
color images. When applied to a True Color image, the operation 

will be applied to all three channels. For example, if you were 
subtracting a value of 10 from the image, 10 would be subtracted 

from the Red value, from the Green value, and from the Blue 
value in each pixel.  

When you select the Arithmetic command, the Image Arithmetic 
dialog box will be presented. Within this box, select the kind of 

operation you want to perform, the image or value you want it to 
work with, and a destination for the results. 

1st Operand  Select one of the files in this list box to tell PhotoLib® what active image to use for the operation. 

Operation 
 Select the kind of operation you want PhotoLib® to perform from the drop-down list box, or click on the appropriate 

"calculator" button. 

  AND 
 Click this button to perform a logical "AND" between your active image and the specified operand. Only bit values 

that are "on" in both operands, will be "on" in the result. 

  OR  
 Click this button to perform a logical "OR" between your active image and the specified operand. Bit values that are 

"on" in either operand, will be "on" in the result.  

  XOR  

 Click this button to perform a logical "XOR" (exclusive OR) between your active image and the specified operand. 

Only when a bit value is "on" in one operand and "off" in the other will the bit be "on" in the result. If bit values are 

"on" in both operands, or if they are "off" in both operands, they will be "off" in the result.  

 NAND 

 Click this button to perform a logical "NAND" between your active image and the specified operand. "NAND" 

produces a result that is the complement of an "AND" operation. Bit values that are "off" in either, or both, 

operands, will be "on" in the result. 

 NOR  

 Click this button to perform a logical "NOR" between your active image and the specified operand. "NOR" produces 

a result that is the complement of an "OR" operation. Bit values that are "off" on both images, will be "on" in the 

result.  

 NOT 

 Click this button to perform a logical "NOT" on the bit values of your active image. Every bit value that is "on" in 

the active image will be "off" in the result. Every bit value that is "off" in the active image will be "on" in the result. 

Use this command to invert the pixels in your image, producing a "negative" effect. 
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 Add 
 Click this button to add the specified operand to the active image. If a pixel's result falls outside of the image's 

intensity scale, it will be clipped to the highest /lowest permitted value. 

 Subtract 
 Click this button to subtract the specified operand from the active image. If a pixel's result falls outside of the 

image's intensity scale, it will be clipped to the highest /lowest permitted value. 

 Multiply 
 Click this button to multiply the active image by the specified operand. If a pixel's result falls outside of the image's 

intensity scale, it will be clipped to the highest /lowest permitted value. 

 Divide 
 Click this button to divide the active image by the specified operand. If a pixel's result falls outside of the image's 

intensity scale, it will be clipped to the highest /lowest permitted value. 

 Absolute  
 Click this button to obtain the absolute value between the specified operand and the active image. If a pixel's result 

falls outside of the image's intensity scale, it will be clipped to the highest /lowest permitted value.  

 Minimum  Click this button to replace each pixel with the smallest value of the two operands. 

 Maximum  Click this button to replace each pixel with the largest value of the two operands. 

 Average  Click this button to replace each pixel with the mean value of the two operands. 

 Invert 
 Click this button to replace each pixel with its inverse (1/pixel). Argument: scaling factor new pixel = scaling factor 

/ original pixel. Pixel values equal to 0 are invalid. 

 Logarithm  Click this button to replace each pixel with its logarithm. Pixel values less than or equal to 0 are invalid. 

 Exponential  Click this button to replace each pixel with its exponent. 

 Square Root  Click this button to replace each pixel with its square root. Pixel values less than 0 are invalid. 

 Square  Click this button to replace each pixel with its second power. 

 X to the 

power of Y 

 Click this button to replace each pixel with its Yth power. Y is limited to positive values. Pixel values less than 0 are 

invalid if Y is less than 1. 

2nd Operand 
 Click the appropriate radio button to tell PhotoLib® what operand (besides the active image) to use for the specified 

operation. 

 Image 

 Set this option if you want to use another image for the specified operation. You must also select, in the adjacent list 

box, the image you want to use. This image must be one that is currently open within PhotoLib®; it cannot be an 

image on disk. The two images need not be of the same image class. 

 Number 

 Set this option if you want to use a constant value for the specified operation. If a logical operation has been 

selected, numbers from 0 - 255 can be entered. If an arithmetic operation has been selected, any value can be 

specified, including negative and fractional values. Scientific notation may be used. 
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Image 

Equation 
  PhotoLib® summarizes your command here. 

Note - Log, Square root, Square, X to Y, and Exp will increase or 
decrease pixel values dramatically and may only be useful when 
used on floating point images. To apply these operations to 8 bit 

images, convert the image into a float point image first.  

Using Log, Square root, Square, X to Y on images containing pixels 
whose values are invalid for the given operation, will result in the 
following approximations: Negative infinite results will be set to 
the minimum value supported by the image type (i.e., 0 for 8, 12, 
16, 24, 36, 48 bit images). Positive infinite results will be set to the 
maximum value supported by the image type (i.e., 255 for 8 bit, 

4096 for 12...). Indeterminate results (e.g., 0/0) will be arbitrarily 
set to the minimum value supported by the image type.  

 
Fig.4.5-7 Image Arithmetic Operation 

4.5.3  PseudoColor(P)... 

Use the Pseudo-Color command to "colorize" the active 
monochrome image. You might do this to highlight certain 

features in a gray scale image. For example, you might want to 
display all densities above a certain point in red, or, if your 

imaging device recorded thermal information, all temperatures 
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below a certain point in blue.  

When you pseudo-color a monochrome image, you build a special 
palette through which your monochrome image is displayed. 
Pseudo-coloring an image does not modify the pixel values in 

your image bitmap in any way (it does not convert your image to 
True Color or Palette, for example). It simply associates a 

pseudo-color palette with the image, thist interprets the gray-level 
values in the image as color.  

Pseudo-colored images are very similar in structure to Palette 
class images, but they differ in a couple of important ways. First, 

the pixel values in a pseudo-colored image actually represent 
continuous-tone intensity information, whereas a Palette image's 
pixel carries no intensity significance. Secondly, a Palette image 

includes a palette table that is actually part of the image file.  

You can select the colors to map to the gray values. The buttons 
at each end of the color strip bring up the color dialog, which 

allows you to select the starting and ending colors of the range. 

 
Fig.4.5-8 PseudoColor Processing 

4.5.4  Range(R)... 

The Range command allows you to set the intensity levels of your 
images to increase contrast and enhance display in low-light 
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situations. Selecting the Range command opens the Range dialog 
box (See Fig.4.5-9). 

Fig.4.5-9 RangeOperation 
Two vertical markers show the upper and lower limits of the 

intensity levels. These markers can be moved with your cursor. If 
you are looking at a color image, the histogram will reflect the red, 

green, and blue values with lines of the same color.  

Two edit controls indicate the values for the intensity levels. You 
can use the spin buttons to increase or decrease these values. All 
values between 0 and your lower limit will be black; all values 

between your upper limit and the upper end of the scale will be 
white.  

Reset   The Reset button allows you to reset the black and white levels to the high and low ends of the dynamic range.  

Best Fit 
 The Best Fit button automatically sets the intensity levels to the "best fit". Best fit instructs PhotoLib® to optimize the 

Brightness and Contrast values for your particular image. 

Inv   The Inv button reverses the image.  

Update  Update refreshes the display range with the most current image information. 

4.5.5  Segmentation(S)... 

Segmentation command is a process by which certain colors (or 
gray levels) in an image can be visually identified then isolated 
from the image as a whole. Areas identified by segmentation 
(classes) can be either removed from the image or kept, while 
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discarding the remainder of the image. Therefore, this process 
can be used for separating items or objects of interest from the 

"background noise" that naturally occurs in most acquired 
images.  

The process of identifying colors is key to the operation of 
Segmentation. Because of the vast differences possible in images, 

and therefore the color composition of the object(s) to be 
identified, PhotoLib® provides Histogram-based models for 

identifying the segmented area. 

When the Segmentation command is activated on a true color 
image, choose one channel of Red, Green and Blue to do 

operation. 

 
Fig.4.5-10 Segmentation 

4.6  Measure Menu 
4.6.1  Histogram(H)... 

A Histogram illustrates how pixels in an image are distributed by 
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graphing the number of pixels at each color intensity level. This 
can show you whether the image contains enough detail in the 

shadows (shown in the left part of the Histogram), midtones 
(shown in the middle), and highlights (shown in the right part) to 

make a good correction (see 4.6-1). 

The Histogram also gives a quick picture of the tonal range of the 
image, or the image key type. A low-key image has detail 
concentrated in the shadows; a high-key image has detail 

concentrated in the highlights; and an average-key image has 
detail concentrated in the middle tones. An image with full tonal 

range has a high number of pixels in all areas. Identifying the 
tonal range helps determine appropriate tonal corrections. 

In a Histogram, the X-axis represents the intensity scale (range 
from 0 to 255), and the Y-axis measures the spatial value (as 

defined by the current spatial calibration). You can use the slide 
bar to adjust the current spatial calibration. 

BkGround Invoke Windows Color dialog to set the background color of the histogram window 

Title Use this command to set title related to each image's histogram 

Capture Capture the active image in the histogram window as a new untitled image 

Copy Copy the histogram window's content into Windows Clipboard 
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Fig.4.6-1 Histogram 

4.6.2  Surface Plot (P)... 

The Surface Plot (or 3-D Plot) tool creates a three-dimensional 
representation of the intensity of an image (see Fig.4.6-2). When 

using the Surface Plot tool, keep in mind that X = length; Y = 
width; and Z = height. 

In viewpoint window, you can adjust the elevation and rotation of 
the image by moving the mouse. 

Pos 

Solid: 

The left edit control indicate the relative position of the entire image in the viewpoint window, default value is 0.5. 

The right edit control indicate the relative height of the display of the Z scale, default value is 1. 

Reset: Set the Pos Solid's two edit control to their default values. 

Img Bk 

Color: 
Choose this command will display a color dialog which you can adjust the background color of viewpoint window. 

Capture: Capture the active image in the viewpoint window as a new image. 

Color: You can select the colors to map the gray values found in the surface plot. The button at each end of the color strip 

bring up the color dialog, which allows you to select the starting and ending colors of the range. (Please refer to 
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Pseudo-Color for more information.) 

 

Fig.4.6-2 3D Surface 
4.6.3  Line Profile (L)... 

Use Line Profile command to illustrate how pixels along a selected 
line are distributed by graphing the number of pixels at each 
color intensity level. Before use this command you must first 

select Layer Manager tool to set the active layer and draw lines on 
it. 

In a Line Profile, the X-axis represents the spatial scale, and the 
Y-axis measures the intensity value (range from 0 to 255, See 

Fig.4.6-3) . 
BkGround: Invoke Windows Color dialog to set the background color of the histogram window 
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Title: Use this command to set title related to each image's histogram 

Capture: Capture the active image in the histogram window as a new untitled image 

Copy: Copy the histogram window's content into Windows Clipboard 

 

Fig.4.6-3 Line Profile 
4.6.4  Bitmap Analysis (A)... 

The Bitmap Analysis command on the Measure menu is used to 
view the pixel values of the active window in numeric format. 
When the Bitmap Analysis command is selected, the Bitmap 

Analysis window is opened and the pixel values associated with 
the active image are displayed (see fig4.6-4). 

Height  You can adjust height of Bitmap Analysis window to display. 

Width  You can adjust width of Bitmap Analysis window to display. 

Zero  Set all pixels in the Bitmap Analysis window to 0. 

Max  Set all pixels in the Bitmap Analysis window to 255. 

Hide  Minimize the Bitmap Analysis window. 

Note: This command is only used for gray scale image. 
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Fig4.6-4 Bitmap Analysis 
4.6.5  Measure(M)... 

When you select the Measure command, the Measure window is 
opened, including every possible measurement for all the features 

and measurements that you have created for the current image 
(e.g. Name, Center Pos, Radius, Area, Perimeter, Angle, Start Pos, 

End Pos). You can resize the columns for a better fit, or to hide 
measurements that are not of interest (See  Fig.4.6-5).  

Before measurement, please select the Measurement Tool you 
need to obtain your measurement. This is done by selecting the 
appropriate tool button (point, line, circle, etc.). When you have 
selected one or more features on the image or the Features page, 
using the selection tool, you can delete the feature and all of its 

related measurements by clicking the Delete button. 

Click right button of the mouse in the measurement table, you 
have following options (see Fig.4.6-6): 

File Input Click this button to load an outline or measurements file (*.measure) to the current image. 

File Output Click this button to save the layout and measurements of the current image to a measurements file (*.measure). 

Length Unit Choose among m, cm , mm or your own defined Length Unit. These units are not the same value as that of physical 
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length. They are related to the resolution set in Set Resolution window. 

Define Unit Define your own Length Unit. 

Angle Unit Choose between Radian and Angle. 

Note: To do your measurement, you must choose right layer first 
(more information in Layer Manager). 

Fig4.6-5 Measurement 

 
Fig.4.6-6 The R-Button Popup Menu 
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Fig.4.6-7 Own Defined Length Unit 

4.6.6  Set Resolution(R)... 

Use Set Resolution command to set your own image resolution to 
calibrate the spatial scale. By default, PhotoLib® expresses spatial 
measurements in terms of pixels. The Set Resolution command is 

used to change the terms in which PhotoLib® report such 
measurements. You should use this command if you want to 

measure objects in terms of microns (Fig.4.6-8).  

 
Fig.4.6-8 Image Resolution Setup 

X Indicate horizontal DPI (Dots Per Inch) of current resolution. By default, the value is set as 7.62. 
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Y Indicate vertical DPI (Dots Per Inch) of current resolution. By default, the value is set as 7.62.You can 

calculate new resolution with following selections. If you want to set horizontal resolution, select X radio 

button or select Y radio button while setting vertical resolution. 

Actual Scale Indicate the dot values set in the Image Dots edit box will represent how many values in micron units. 

Image Dots Indicate the micron values set in the Actual Scale edit box will be represented by how many pixel dots on the 

screen. 

After set up Actual Scale and Image Dots edit box properly, click 
Calculate button will calculate related resolution that will be 

displayed in Resolution static box in DPI unit. Click Set Value 
button will set the calculated value as current resolution while 

updating values in X and Y edit box. When set appropriate 
resolution, all measurements will be displayed with this unit. (See 

more in Measure command). 
4.6.7  Mass Counting (C)... 

Use the Mass Counting command to perform counting operation. 
This command is performed on the entire image. 

The basic steps involved in a counting task are to: 

Set the range of intensities that identify the object you want to 
count using the tools in the Counting Setup dialog box or with 

Point Based Counting command. 

Select the kinds of measurement you want to record in the Mass 
Counting. 

The total sum and the effect of Mass Counting will be displayed in 
the Mass Counting dialog's preview window. All counted cell will 

be filled with the color and indicated with sign number and 
coordinate both of which can be adjusted with Setup button. 

Click Set On Image button to set the current effect displayed in 
preview window on the actual image. 

Click Close button will close the Mass Counting dialog box. 

Note: This command can only be used on gray level image. 
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Fig.4.6-9 Counting 
4.6.8  Point Based Counting (P)... 

Use Point Based Countin command to set current mouse-point's 
pixel value as upper limit of Gray level used for Mass Counting 

operation. 
4.6.9  Counting Setup (T)... 

Before performing your Mass Counting operation, be sure 
following options have been set up properly: 

Limited Condition: 

Gray 
Set Gray level range used for Mass Counting. If you set range from 0 to 128, then only the pixels in this range will 

be taken into consider. You can set the range manually or use Point Based Counting command. 

Girth 
Set Girth range used for Mass Counting. If you set range from 1 to 10000, then only object of image with girth in 

this range will be taken into consideration.   

Area 
Set Area range used for Mass Counting. If you set range from 1 to 10000, then only object of image with area in 

this range will be taken into consideration. 

4 Connection 
 Indicate pixel's connection relationship with neighbors'. When counting, each pixel's north, south, east and 

west direction's neighborhood will be taken into consideration.  

8 Connection  Indicate pixel's connection relationship with neighbors'. When counting, each pixel's north, south, east, west, 
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northeast, southeast, northwest and southwest direction's neighborhood will be taken into consideration.  

Cell 
 We can fill in the right counted object with the color we specified in R, G, B edit box (each part range from 0 to 

255) or use Select Color button to activate windows color dialog.  

Sign the 

Order 

 If check this box, every object will be indicated by sign number and coordinate with the color we specified in R, 

G, B edit box (each part range from 0 to 255) or use Select Color button to activate windows color dialog. 

 

 
Fig.4.6-10 Counting Setup 

4.7  View Menu 

In this View menu you can select to display specified bars or 
boxes in the frame window by clicking the corresponding 
command. Also you can adjust display mode in this menu. 

4.7.1 Toolbar 

Most tools have shortcut that are displayed in the tool options bar, 
including New, Open, Save, Import Photo, Single Capture, Undo, 

Redo, Delete, Cut, Paste, Print Preview, Print,  About, Quick 
Zoom. The Toolbar is context sensitive and changes as different 

tools are selected. The first time you start the application, the 
Toolbar appears at the top of the screen. 
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4.7.2 Statue Bar 

Most statistic data of active image can be seen at statue 
bar ,including display unit, image bit count, image height, image 
width, resolution (see more information in Set Resolution dialog ) 
and so on. The first time you start the application, the Statue Bar 

appears at the bottom of the frame window.  

Tool Box 

The first time you start the application, the ToolBox appears on 
the left side of the frame window. Some tools in the toolbox have 

options that appear in the context-sensitive tool options bar. 
These include the tools that let you select, paint, draw, annotate, 
sample, erase, fill, adjust Brightness/Contrast, scale and panning 

image. Using Paint and Draw tool, you can draw Point, Line, 
Angle, Rectangle, Round Rectangle, Ellipse, Polygon and Text on 
specified layer (See relative information in Layer Manager and 
Draw Default).  After you draw or paint on the image, you can 

use Select tool to choose the object you are interested and you also 
can choose Measure -> Measure to see more statistic details such 
as order number, name, center position, radius, area, perimeter, 
angle, start position, end position. The four tools following Paint 
and Draw tool allow you to change relative position of selected 

component on specified layer. Sample tool can be used to Pick out 
specified pixel intensity value (for gray level image) or color value 
(for true color image) in the image by pointing it out with moving 

mouse, which can be set as foreground or background color. 
Erase tool make you replace pixels with background color as you 
drag through them. Fill tool fills adjacent pixels that are similar 
in color value to the pixels you click. Brightness/Contrast tool can 
adjust image's brightness (horizontally) or contrast (vertically) by 

moving mouse with left button down (see how to change step in 
Set Up command). If choose Scale tool, click mouse's left button 
will enlarge image size and click right button will reduce image 
size following the percentage order listed in the Quick Room. If 
image's Actual Size is larger than that of frame window, using 
Panning tool to move image to show interested part in frame 
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window.  It has the same function as scroll bar.  

Paint Box 

Paint Box let you choose foreground and background color with 
Sample tool (select in ToolBox). By default, the foreground color 
is set as White (255) and the background color is set as Black (0). 
If active image is 24 bits true color, use Windows color dialog to 
make selection. If active image is 256 indexed image, all palette 

colors will be displayed in Paint Box. Then you can specify 
foreground color and background color not only from Windows 

color dialog but also from palette color listed.  

Browser 

Choose   command to manage images on hard disk.  When 
click  Browser, it will display a Browser window look like 

Windows explorer.  The left side of the Browser window is the 
direction on hard disk and the right side show images' preview 

under the right direction you specified. Click right button of 
mouse in the right side will pop out a menu in which Browser lets 
you delete, refresh, select , sort, and process image files. You can 
use the Browser to perform tasks such as creating new folders; 

renaming, moving, and deleting files. You can also view 
individual file information and data imported from your digital 

camera. Double click an image will display it with full size as 
active image. You can choose to display full screen images with 

Manual play style or Auto play style. For Auto choice, set related 
parameters in Play Setup 
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Fig.4.7-1 Image Browser 
4.7.3 Layer Manager 

Layers allow you to work on one element of an image without 
disturbing the others. Think of layers as sheets of acetate stacked 
one on top of the other. Where there is no image on a layer, you 

can see through to the layers below. You can change the 
composition of an image by changing the order and attributes of 
layers. In addition, special features such as adjustment layers, fill 

layers, and layer styles let you create sophisticated effects. See 
more details in Layer Manager. 
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Fig.4.7-2 Layer Manager 

 
Fig.4.7-3 Property of Layer 

4.7.4 DB Image Browse 

If you have used Open Database command to establish a 
connection with a database file, then this command help you to 

view images in it. 
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Fig.4.7-4 DB Browse 
4.7.5 Zoom In 

Click the Zoom In command (<Ctrl>+<+>) to magnify image to 
the next preset percentage listed in Quick Room. Each click 

magnifies the image to the next preset percentage, centering the 
display around the point you click.  

Zoom Out 

Click the Zoom out command (<Ctrl>+<->) to reduce image to 
the previous preset percentage listed in Quick Room. Each click 
reduces the view to the previous preset percentage, centering the 

display around the point you click.  
Actual Pixel 

Click the Actual Pixel command to set the active image to its 
actual size(e.g. 100%).  

Fit on Screen 

This command scale both the zoom level and the window size to 
fit the available screen space. 

4.7.6 Display Unit 

Display image statistic in the unit of Pixel, Millimeter or Inch.  
Partial View 

Use this command to magnify partial selected image to display, 
You can set up relative settings in the Set Up -> Partial View 

Default.  
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Fig.4.7-5 Partial View 

4.8  System Setup Menu 

In Set Up menu ,you have following options: 
4.8.1   Company Name 

Enter your company's name in the following dialog�s edit box. 

 
Fig.4.8-1 Company Name Setup 

4.8.2  Space Set 

Use this command to set up Brightness/Contrast change step. The 
value entered in the edit box will be used to calculate adjust step 

according to mouse move scale on the screen. For example, 
assuming enter value is 30 (unit = pixel) and moving mouse on the 

screen with 60 pixels, then value 2 (60/30) will be used for 
brightness or contrast adjust. The smaller enter value and longer 

mouse-moving distance mean the more distinct effect of 
Brightness/Contrast operation, and vice versa. 
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图 4.8-2 Space set 

4.8.3  Drawing Default 

When select this command ,display a setup dialog in which you 
can set all default drawing properties. See more in Drawing 

Default. 

 
图 4.8-3 Drawing setup 

4.8.4  Sys Magnification 

This command can be used in the setting of the Video In Devices 
magnification or resolution. See more in System Magnification. 
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图 4.8-4 Sys microscope setup 

4.8.5  Partial View Default  

Set default settings of partial view. You can set Gamma 、
Brightness and Contrast values. You also can set width 、height 

and scale values of partial view.  

 
Fig.4.8-5 PartialView Default 

4.8.6  Auto Clipping Range 

Set the upper level and low level used for Auto Level and Auto 



Chapter 4                  The Main Functions of the 
PhotoLib3.0                         4-74 

 

Contrast command. 

 
Fig.4.8-6 Auto Clipping Range Setup 

4.8.7  Play Setup 

If choose Auto play style in Browse command, set related 
parameters in this dialog 

 
图 4.8-7 Play Setup 

4.8.8  Print Selection 

User can select whether to print page header or page footnote, at 
the same he can determine whether to print the image label and 
measured parameters. He can also select different  integration 

manners 
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Fig.4.8-8 Print Setup 

4.9  Window Menu 

Window menu commands control the display of images in 
PhotoLib®. You can arrange the display of multiple images in the 

PhotoLib® workspace. 

New Window: Create a new image of the active image.  

Cascade: Use the Cascade Images command to arrange your open 
image windows so that they are roughly equally-sized and layered, 
leaving only their title bar and left border visible. Cascade Images 

rearranges only the open image windows. 

Tile: Use the Tile Images command to arrange your open image 
windows so that all windows are visible and roughly equally sized 

across the screen. Tile Images rearranges only the open image 
windows. 

Arrange Icon: 

4.10  Help Menu 
4.10.1  Help Content 

Click this command to invoke PhotoLib®'s online help system.  
4.10.2  About 

Show relative information about PhotoLib® including Version, 
Date and Company name etc.
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Chapter 5 Appendix 
5.1  How to Set the System Magnification (Microscope) 

The correct setting of the microscope magnification index is the 
premise for the correct measurement. If you have selected the 
Sunny Group�s digital microscope and software, the system 

magnification has set for you in advance. Please do not modify it. 
If the hardware is bought from other companies, please set it by 

yourselves. Here we will show how to set the system 
magnifications step by step according to the hardware-SZM 

Digital Microscope (Note: you should have reticule with cross at 
hand and it�s accuracy should be smaller than 0.1 micrometer). 

Step 1：Connect the SZM digital microscope with computer and 
execute PhotoLib3.0。 

Step 2: Select Setup->Sys Magnification menu, a Microscope Setup 
dialog box will shown as in Fig5.1. No input the microscope 

magnification indexes just as the same as you microscope has, for 
example ： 4.5X:4X:3X:2X:1.5X:1X:0.8X:0.7X . Check it and 
click Save Index button and you will find the input indexes are 

shown in the Magnification combo box (Fig5.2)。Click Ok button 
to exit Microscope Setup dialog box. 
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Fig.5.1 Microscope Setup 

 
Fig.5.2 Microscope Setup 
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Step 3：Adjust the microscope Magnification Index to 4.5X，then 
adjust to focus the reticule and made it clear。Select Import 

Image-> VFW Capture, a video window will be shown as in Fig.3. 
Set the magnification index to 4.5X(See Fig.5.3). Click Capture 

Button and capture the image to the image window (See Fig.5-4). 
Using Select Tool to select a reticule whose length is 1mm as 

shown in Fig.5-4. In the status Bar, you will find the selection 
rectangle information labeled in red color, we found the width of 
the rectangle is 199, an average value can be arrived by repeating 

the above step) 

 
图 5-3 
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图 5-4 

 

 
图 5-5 

Step 4：Adjust the microscope Magnification Index to 4.5X，then 
adjust to focus the reticule and made it clear。Select Import 

Image-> VFW Capture, a video window will be showed as in Fig.3. 
Set the magnification index to 4.5X(See Fig.5.3). Click Capture 

Button and capture the image to the image window (See Fig.5-6). 
Using Select Tool to select a reticule whose length is 1mm as 

shown in Fig.5-6. In the status Bar, you will find the selection 
rectangle information noted in red color, we found the width of 

the rectangle is 245, an average value can be arrived by repeating 
the above step) 
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图 5-6 

 

 

图 5-7  
Step 5：In step 4 and Step 5, we got the Width(X) 199 and 

Height(Y) 245 relative to 1mm reticule length。Select Setup->Sys 
Magnification menu, a Microscope Setup dialog box will be shown 

as in Fig5-6. Select the single selection button X and input 
1000(um) in the Actual Scale: edit box. Type 199 in the Image 

Dots: Edit box, click Calculate button, 5054.6 will be showed in 
the Resolution box. Click Set Value button, then this value will be 
displayed in the Res X box. Perform the same step then you will 

get the resolution in the Y direction. The result is shown in Res Y 
box as shown in Fig.5-9. 
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图 5-8  
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图 5-9 
Step：Repeat Step 4 and 5 and we can get different resolution for 

its corresponding magnification indexes. 

Now ，you can test whether our settings are correct or not. Select 
Import Image-> VFW Capture, a video window will be shown as in 
Fig.3. Set the magnification index to 4.5X(See Fig.5.3). Focus the 

microscope to made the reticule clear and capture the image. 
Measure the length as shown in Fig.5-10 and Fig5-11. The data 

shows verify that our setting is correct. 

 
图 5-10  

 

 
图 5-11  
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